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CAPITULO 1 - INTRODUGAO

1.1 — TECNOLOGIA BIM

Com o passar dos anos, a utilizagdo da tecnologia BIM (Building Information
Modeling) é cada vez mais presente na area da construgdo civil como um todo,
envolvendo técnicos, engenheiros e arquitetos, principalmente por sua facilidade em
solucionar problemas enfrentados ha muitos anos no setor, como a gestdo de projetos.
Essa tecnologia pretende especificar e unir as informacdes e os atributos dos projetos
de uma construgao de forma integrada e organizada. Sendo assim, através de softwares
baseados no BIM, um modelo 3D detalhado da obra, por exemplo, garante um resultado
muito mais minucioso e fiel do que os protdtipos 2D ou mesmo modelos que garantam
apenas algumas perspectivas em 3D.

Juntamente da evolugdao da era digital, houve a apari¢dao de inovag¢des que
auxiliam os mais diferentes setores da sociedade e, na construcao civil, ndo é diferente.
Com o uso de tecnologias, como o BIM, a etapa de elaboracdo e planejamento dos
projetos de uma obra se torna mais eficiente, assim problemas na execucdo e no pds-
obra sdo evitados. Isso implica na reducdo dos custos e agiliza uma obra, além de
aumentar a qualidade das edificagdes.

1.2 — O SOFTWARE

O Revit é um software desenvolvido pela empresa Autodesk, mesma empresa
tem os dominios de um dos programas computacionais de engenharia mais famosos, o
AutoCAD. Com a utilizagdo da tecnologia e suas ferramentas, é possivel elaborar
modelos para a concepgao de projetos arquitetonicos, de infraestrutura e de sistemas
mecanicos. Além da facilidade intuitiva ao se utilizar, foi desenvolvido para que os
projetos estejam conectados. Ou seja, se é feita alguma alteracdo em qualquer ponto
do projeto, os dados e documentos atrelados a ele sofrem a mesma modificacao,
diminuindo consideravelmente o tempo de elabora¢ao do projeto.

Além disso, o programa permite a rapida elaboracdo de vistas, perspectivas e
cortes de rapida visualizacdo ou atreladas a alguma prancha que pode ser elaborada
pelo préprio autor, bem como a geracdo de planilhas orcamentdrias e até mesmo
quantitativos.

Vale ressaltar que a versao utilizada como objeto de estudo para a elaboracao
desta apostila sera o Revit 2020, contudo, o que for citado posteriormente em relagdo
aos comandos do software equivalem pra edicdes anteriores, visto que o programa
sofreu apenas pequenas atualizacdes ano apds ano.
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1.3 — INTERFACE

Partindo entdo para o uso do programa, ao abri-lo pela primeira vez, o usuario

encontrard algumas opg¢bes na tela inicial para que possa dar inicio a um novo projeto.

Se o projetista deseja iniciar um projeto do zero, é necessario clicar na op¢dao New
(Novo) na aba Models (Modelos). Ja a aba Families (Familias), € uma funcdo adotada
pelo software que se refere a um conjunto de elementos de propriedade comum,

normalmente relacionados a itens da constru¢do como mobilias, esquadrias, tabelas,

entre outros. De acordo com o uso, os arquivos que forem acessados, comegardo a

aparecer na aba Recent Files (Arquivos recentes). Na figura a seguir, é possivel notar os

recursos iniciais disponiveis.

R[E Autodesk Revi 2020 - STUDENT VERSION - Home

& Recent Files  Learn -
MODELS

MODELS

FAMILIES

FAMILIES

Sample Structure Project

FIGURA 1.1 —TELA INICIAL DO REVIT 2020
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CAPITULO 2 — CRIANDO O TEMPLATE PARA UM NOVO PROJETO

2.1 — NAVEGACAO

O programa conta com ferramentas espalhadas na tela de elaboracao do projeto
que se organiza basicamente da seguinte forma: Uma “Barra de Guias” (Ribbon)
localizada na parte superior da tela que facilita o acesso aos menus e comandos que se
deseja realizar como, por exemplo, elementos arquiteténicos como parede, esquadrias,
piso, entre outros. Uma barra de “Propriedades” (Properties) a esquerda da tela onde é
possivel obter e alterar informacdes do objeto que esta sendo manuseado no momento.
O “Navegador de Projeto” (Project Browser), localizado a direita da tela, consiste em
uma lista de familias, grupos e, principalmente, vistas do projeto, podendo ser alteradas
a qualquer momento. Por fim uma Barra de Controle de Vistas que consiste
principalmente em configurar elementos visuais do projeto como Escala, Caminho do
Sol, Sombra, Estilo Visual, entre outros. Vale ressaltar que estes menus podem ser
alterados de lugar conforme o projetista sentir-se mais a vontade de trabalhar, logo,
quando o programa for aberto, ele pode estar localizado em algum outro lugar
naturalmente.

A seguir, na Figura 2.1, uma demonstracao visual do programa no momento que
se inicia um novo projeto.

Modiy Wl Doo

~ | B8 Edit Type
£~

we [0 ]

alue 1
Model  Narmal

v w0 5k G 0 Lalila <
Click to select, TAB for atternates, CTRL adds, SHIFT unselects & o [E - e el g F O To

FIGURA 2.1 — AREA DE TRABALHO DO REVIT 2020
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2.2 — ATALHOS

Como de costume nos
softwares da Autodesk, o Revit
dispde de alguns atalhos para
facilitar e tornar o processo de

trabalho mais agil na plataforma.

R Keyboard Shortcuts

Search: | Type a command name
Eilter: | All

Assignments:

Command Shortcuts

Modify MD
Select links
Select underlay elements

Select pinned elements

Paths

Create>Select; Insert>Select; Ann...

Create>Select; Insert>Select; Ann...
Create>Select; Insert>Select; Ann...

Create>Select; Insert>Select; Ann...

Por exemplo’ >€ 0 usuario deseja Select elements by face Create>Select; Insert=Select; Ann...
criar uma parede, além de clicar no | | orag eiements on select.. CreatesSelect; Insert> Select; Ann..
comando “Parede” (Wall), na aba || """ Creste-Froperies Moy -Prepe..

Properties PP Create>Properties; View>Windo...
“Arquitetura” (Architecture), Culs

VP

localizada na barra de guias, o

Family Category and Par... Create>Properties; Modify>Prope...

projetista pode apenas digitar o

Press new keys: Assign Remove

atalho “WA” para usar o programa.

| Import... | | Export... ‘ | oK ‘ | Cancel ‘

Para acessar a relacdo dos
atalhos do programa, valendo ressaltar que, caso seja da escolha do projetista, hd a
possibilidade de alterar de acordo com a maneira que se sentir mais confortavel, é
preciso que va em Vista (View), depois “Interface do Usudrio” (User Interface) e em
seguida “Atalhos de Teclado” (Keyboard Shortcuts). Detalhe que hd também um atalho
para chegar nesse menu, basta apenas digitar “KS”.

2.3 — UNIDADES

Um detalhe simples, porém, de extrema importancia quando vai se iniciar um
projeto é configurar a unidade que se ird trabalhar. Para acessar essa aba, digita-se o
comando “UN”. Nela, aparecera Discipline (Disciplina), que é uma ferramenta que serve
para determinar qual o modelo de projeto que esta sendo trabalhado. Para alterar as
unidades, é necessdrio clicar em Format (Formato), onde abrirad outra janela que onde é
possivel alterar coisas como a prépria Units (Unidades), Rounding (Arredondamento das
casas decimais) e Unit symbol (Simbolo de unidade). Por fim, para salvar as alteracdes
feitas conforme a necessidade e preferéncia do projetista, basta clicar em “OK”.

2.4 — DEFINICAO DE TERRENO

Ferramenta responsavel por poder inserir a dimensdo do terreno, deste modo,
guando for necessario colocar caracteristicas de topografia, serd mais facil. Para ter
acesso a essas informacoes, basta ir no menu Massing & Site (Massa e terreno),
localizado na barra de guias do programa.

SOHTVLY 3d NNIIN — ¢°¢ V4NSI4
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REeHG K- A 2-SO0A G0 e Autodesk Revit 2020 - STUDENT VERSION - Project1 - Floor Plan: Level 1
File Architecture  Structure  Steel  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View Manage Add-Ins  Modify &~
) ¥ OO wWO0sS Q [ @
v & 20
Show Mass . In-Place Place Curtain Roof Wall Floor Toposurface Site Parking Property
Form and Floors Mass Mass System Component Component Line
Select Conceptual Mass Model by Face Model Site El Modify Site

FIGURA 2.3 — MENU MASSA E TERRENO

2.5 — CRIACAO DE NIVEIS

Os niveis de uma construcdo sdo basicamente a cota que o piso, o nivel da rua,
um possivel segundo pavimento de uma edificacdo terd, teoricamente. Logo, é uma
configuragdo que é necessaria ser feita no inicio do projeto e, para isso, € necessario que
o projetista esteja em alguma das “Elevagbes” (Elevations) que sdo encontradas no
Navegador de Projeto. As elevacdes existentes sdo os quatro pontos cardeais: Leste
(East), Norte (North), Sul (South) e Oeste (West). Para acessar o comando onde é
possivel configurar a cota dos niveis do projeto, basta apenas digitar “LL".

S E2-LOAN GO 0B Autodesk Rewit 2020 - STUDENT VERSION - Project - Elevation: East “ma R @- _ & x

te  View Manage Adddms  Modity D

X [7] Nieldafua % East X = Properies X
ﬁ Elevation
Buiding Elevation
oo Elevation: East R Edit Type
Seg. Pavimenta .

Graphics A
ste View s 1100

émeo

Ceiling Plans

Cobertura
Mivel da Ru

< > rie % Guias® o tadh I < > Rmtelel
Clickto select, TAB for altemates, CTRL adds, SHIFT unselects & o @ 7 2 8 (8 O Vo

FIGURA 2.4 — NiVEIS

Vale ressaltar que os niveis criados aparecem no Navegador de Projeto, nas abas
de “Plantas de piso” (Floor Plans), “Plantas de forro” (Ceiling Plans) e “Plantas
Estruturais” (Structural Plans).

2.6 — PROJECAO DE VISTAS

Primeiramente, é necessario escolher os “Identificadores de Elevacdo” (Elevation
Tags). Para isso, acessar na aba “Gerenciar” (Manage), encontrada na barra de guias do
programa, o atalho “Configuracdes Adicionais” (Additional Settings).
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Na janela que abrir, é preciso configurar a marca de elevacdo desejada, clicando
duas vezes sobre o icone para exibir a vista da edificacdo pela orientacdo selecionada.

2.7 — DETALHAMENTO DAS VISTAS

Na Barra de Controle de Vistas, é possivel configurar detalhes referente as vistas,
perspectivas e cortes do projeto, ou seja, escolher o modo de visualizagdo e nivel de
detalhamento do projeto. Nas figuras a seguir, os menus que essas op¢oes podem ser

acessadas.
4 Graphic Display Options...
) Wireframe
7 Hidden Line
) Shaded
[ coarse 57 Consistent Colors
=1 Medium &7 Realistic
EA Fine Ray Trace
1:100 Fix kEME? 6 RAHIE < 1:100 O kdE > o Cafyra <
FIGURA 2.5 — QUALIDADE FIGURA 2.6 — DETALHAMENTO

2.8 —SALVAR O TEMPLATE DO PROJETO

Apds todas as configuracdes iniciais feitas, é possivel utilizar esse modelo para
outros projetos futuros. Vale ressaltar que para salvar como template, o arquivo tem
formato (.rte) e arquivos salvos como projeto, possuem o formato (.rvt).

REcGHG %-~-Q e -Ff0A G-0F U=

Architecture  Structure  Steel  Systems  Insert  Annotate  Analyze  Massi

= P4
ol E Saves current project or family. Saves current E @

project as a template. Save any family, group or b Floor Curtair

iew t library.
D New . view to your library. - .
Cloud Model
LC Saves the current Revit model to the
B Open » doud. [ Tén

uj Project
E Saves the current Revit praject file,
Save

Family

Saves the current family.
g Save As >
Template
Saves the current Revit project file as a
a3

E‘i’ Export » template.

Library
m Saves a copy of all loaded families, the ’

@ Print » selected family, group, or view to your
library.

E Close D

- BT Families
[@] Groups
&2 Revit Links

FIGURA 2.7 — MENU PARA SALVAR O ARQUIVO
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CAPITULO 3 — MODELAGEM

3.1 — PAREDES

A construgao das paredes compde uma das principais partes da modelagem de
um projeto. Para ser possivel editar esse quesito, é necessdrio que se abra uma vista de
alguma planta de piso ou de uma vista 3D. Apds isso, o comando para comegar a
elaboracdo, pode ser acessado na aba “Arquitetura" (Architecture) e, sem seguida, em
“Parede” (Wall). Outro método para acessar esse comando, é digitando “WA”. A parede
selecionada podera ser usada para criagdo de projetos arquitetdnicos ou estruturais.
Apds ativado o comando, clica-se, arrastando o mouse e informa-se o programa a
medida necessdria do seu desenho, digitando a distancia no teclado numeérico. Nesse
software, é possivel criar estilos de paredes com espessuras distintas, bem como o
material que as partes da estrutura compdem. Para isso, com o comando parede ativo,
acesse na aba Propriedades (Properties) -> “Editar Tipo” (Edit type) -> “Duplicar”
(Duplicate). Ao inserir o nome do novo modelo de parede, é necessario acessar em
“Editar” (Edit) para alterar detalhes como espessura, material e pintura.

Edit Assembly x

Family: Basic Wall
Type: Parede
Total thickness: 0.1500 Sample Height:
Resistance (R): 0.2282 (mz-K)/w
Thermal Mass: 14.32 KI/K

Layers

EXTERIOR SIDE
Function Material Thickness Wraps | Structural Material

1 |Finish 2 [5] Gypsum Wall Board 0.0400

2 |Core Boundary Layers Above Wrap 0.0000

3 |Structure [1] Brick, Common 0.0900 1

4  |Core Boundary Layers Below Wrap 0.0000

5  |Finish 1 [4] Default New Material 0.0200

INTERIOR SIDE
Insert Delete Up Down

Default Wrapping

At Tnserts: At Ends:

Do not wrap ~ None ~

Modify Vertical Structure (Section Preview only)

Modify Merge Regions Sweeps
Assign Layers Split Region Reveals
<< Preview

FIGURA 3.1 — MENU DE EDICAO DE PAREDE

11
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Em relagdo a altura da parede, ela pode ser alterada de duas maneiras:
colocando o valor manualmente, ou seja, desconectada de qualquer outro nivel
existente no projeto, ou, de fato, conectando a um dos niveis e sua altura serd
basicamente da planta de piso que ela for desenhada até o nivel selecionado.

Cadeia: esse modo deve ser selecionado quando deseja-se manter uma
continuidade na construcdo das paredes. Em outras palavras, o final do primeiro
elemento é o inicio do segundo e assim sucessivamente.

Linha de Localizacdo: Define o ponto de referéncia na estrutura que se dara a
partida do desenho. Por exemplo, face de acabamento interna, significa que o ponto de
partida se dard no ponto interno da mesma. Sempre que possivel quando iniciar a
construcdo do elemento utiliza-se a linha do eixo que cruza no meio da parede.

Ao criar um elemento de parede que se unem, é possivel coloca-las respeitando
uma camada de material em particular em relagao a outra camada por exemplo na
alvenaria de concreto.

Status de unido: Isso permite ou ndo unir o topo das paredes quando as mesmas
se encontrarem.

Editar um perfil de parede: apds “construidas” as paredes, é possivel modificar o
seu perfil e desenho, por meio do comando “Editar Perfil” (Edit Profile). Esse comando
é interesse para criar situagGes arquitetonicas, bem como analisar a possibilidade de
colocar uma determina esquadria. Para fazer esse tipo de edicdo, é necessario colocar
em alguma vista das eleva¢Oes ou cortes, além de, claro, selecionar a parede que se
deseja configurar.

3.2 - PISOS

Para acessar esse comando e permitir que possa inserir um piso, é necessario
selecionar a opc¢do “Piso: Arquitetura” (Floor: Architectural), na aba “Piso” (Floor), em
“Arquitetura” (Architecture).

O passo mais simples é inserir algum tipo de piso que ja consta no seu Template.
Contudo, o software disponibiliza alguns pisos ja configurados e disponibilizados para o
usuario utilizar.

E possivel inserir varias camadas de “pisos”, editando as propriedades de cada.
Isso facilita para uma melhor estimativa dos quantitativos e realidade do seu projeto
uma vez que podemos criar camadas referente ao contrapiso e revestimento por
exemplo. O procedimento de insercdo serad igual para todos os tipos.

Uma vez selecionada a op¢ao, uma nova barra de ferramentas ira abrir para
guiar a insercdo do elemento.

12
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FIGURA 3.2 — FERRAMENTAS DE DESENHO PARA PISOS

Uma série de opcdes sera disponibilizada para ajudar, de maneiras diferentes, a
desenhar o piso. Podemos inserir o elemento selecionando as linhas do perimetro,
desenhando linhas, retangulos e outras. O importante é saber que depois de realizado
a acao, o projetista devera assinalar Qﬁ para concluir a a¢do, caso contrario, nao
sera salvo.

O projetista deve ficar atento o nivel que estd trabalhando, pois o piso serd
inserido nele. Caso seja de interesse mudar a cota, basta alterar no Menu
“Propriedades” (Properties) com o piso selecionado.

Para criar um novo piso com as caracteristicas desejadas pelo projetista, é
necessario fazer um procedimento semelhante ao aplicado no comando de “Paredes”
onde, basicamente, se duplicou um modelo genérico do software, renomeando com um
nome diferente dos demais, fazendo as alteracdes necessario. Relembrando o
procedimento, é preciso acessar “Editar Tipo” (Edit Type) e, nesta aba, deve-se entrar
em “Editar” (Edit), ao lado de “Estrutura” (Structure).

Apds isso, podera ser feitas as devidas alteragdes selecionando o novo material
e caracteristicas, acessando “Editar” (Edit) ao lado de “Estrutura” (Structure).

Ao editar as novas configuracdes pode-se criar varias camadas, selecionando
novas fungdes ao novo material, como: regularizagado, reboco e acabamento, na opgao
funcdo. Nesse menu, é possivel alterar detalhes como o material, clicando em “...”, na
coluna Material, ou até mesmo mudar a espessura do piso. Configuragdes mais
avancadas permitem a insercdo de imagens reais, configuracdo de dimensdes da
ceramica e rejunte, por exemplo, aumentando a fidelidade do projeto em uma futura
execucao da obra.

3.3 — ESQUADRIAS

Esse comando é composto por portas e janelas, sendo sua insercdao de maneira
simples. O software disponibiliza um modelo de folha Unica para portas e um modelo de
janela.

Para realizar a insercao de uma porta, por exemplo, deve-se ir na aba
“Arquitetura” (Architecture), através do icone “Porta” (Door).
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Uma vez escolhida a op¢dao da porta e suas dimensdes,
devera ser inserida seguindo as especificagbes do projeto r
arquitetonico. As flechas contidas no raio de abertura giram a
porta alterando o sentido da abertura, clicando nelas, o sentido é

invertido.

A mesma mudanc¢a de dire¢ao pode ser realizada apertando-se a tecla “Espag¢o”
no teclado, enquanto se define a posicdo da mesma. O projetista também pode editar
o elemento entrando nas ferramentas de edicdo e seguindo os mesmos procedimentos
ja descritos nos itens anteriores.

Importante: Nao esquecer de duplicar e renomear o novo material antes de
iniciar a edicao.
Para a insercao das janelas o procedimento serd o mesmo, a Unica diferenca sera

que o projetista deverd selecionar o item “Janela” (Window) apds entrar na aba
“Arquitetura” (Architecture).

3.4 —LAJES

De antemao, é preciso dizer que o programa ndo possui um item especifico para
esse item para configura-lo e inseri-lo, logo, o elemento estrutural estd comtemplado
no item “Piso” (Floor). Na aba “Arquitetura” (Architecture) o projetista devera clicar em
“Piso: Estrutural” (Floor: Structural). Acesse um elemento ja disponibilizado pelo Revit e
faca as edicbes do elemento renomeando o elemento para “lLaje”. As demais
informacgdes ficam a critério do projetista, mas aconselha-se usar uma espessura de 10
centimetros. Em contrapartida, ha o item “Forro” (Ceiling), que possui configuracdes
semelhantes de insercdo e configuracdo ao do piso.

As ferramentas disponiveis para edicdo nesse quesito, sdo 0s mesmos
paresentados no subcapitulo que tratou sobre os pisos, consequentemente, a maneira
para acessa-las é a mesma, também.

A insercao do elemento se da escolhendo a opg¢ao que melhor quase adapte ao
projeto entre as op¢des disponiveis, de modo que se desenhe o perimetro que se deseja
estimar a estrutura. Lembrando que se deve concluir o procedimento ao final para
salvar.

E importante verificar no menu “Propriedades” (Properties) do elemento, as
informacdes de nivel, principalmente em projetos de um pavimento. Qualquer
modificacdo pode ser facilmente modificada.

DICA: Aconselha-se trabalhar em metros. O projetista deve verificar em qual
unidade de medida esta usando ou configurar o inicio do projeto.

14
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3.5 — SHAFTS E CORTES VERTICAIS

Inimeras edificagGes necessitam da presenca de uma abertura que se estenda em
diferentes niveis ou a construgdo inteira, por exemplo, para a instalagao de descidas de
tubulacdes, escadas e até mesmo elevadores, que sdo os exemplos mais comuns. Para
inserir esses shafts ou cortes verticais, é necessdrio seguir o seguinte procedimento:

e Acessar a aba “Arquitetura” (Architecture), na se¢ao “Aberturas” (Opening),
clica-se em “Shaft”;

e Defina a ferramenta de desenho da abertura e faga seu dimensionamento;

e Configure as alturas e deslocamentos do “Shaft” no menu “Propriedades”
(Properties);

e Conclui-se as mudancas e se confirma a criacdo da abertura;

~ ) gfl: = Wall

i \E

By Vertical

By Shaft & o @

Face J Dormer
Opening

FIGURA 3.4 — COMANDOS DA SECAO “ABERTURA”

3.6 —ESCADAS o

Ao se tratar de uma edificacdo |Sc X
que possui andares além do térreo, ou e st e
até mesmo uma entrada que possui
uma cota maior que o nivel da rua, uma | e

das possibilidades para unir esses | et

Minimum Result for Stair Calculator =

pontos é inserindo uma escada. | e wememomn
Partindo para esse topico, é importante | .omn-
ressaltar que o software permite

realizar o calculo da Férmula de Blondel

(63<2Espelho + Piso<64). Dentre as

opcOes ofertadas no programa, tem-se

escadas de modelo “U”, “L” e espirais. A

] ) ] = B
seguir serd demonstrado como editar | |

cada uma. FIGURA 3.5 — CALCULADORA PARA DIMENSIONAR A ESCADA
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3.6.1 — ESCADAS RETAS

Menu: Na aba Arquitetura (Architecture), localiza-se o comando “Escada”
(Stair) na se¢do “Circulagdo” (Circulation).
Propriedades (Properties): “Restricdes” (Constraints) -> Define-se o “Nivel Base”
(Base Level) de inicio e o “Nivel Superior” (Top Level) que terminard a escada.
A escada normal é a que o projetista pode desenhar de acordo com o seu projeto.
Para executar uma escada normal:
e Define-se a linha de localizagcdo da escada (é recomendado suporte externo
direto);
e C(Clica-se em um ponto inicial;
e Arrasta-se para definir o caminho da escada;
e Clica-se em um ponto final.
e Finalize a escada clicando no botao Qf .

3.6.2 —ESCADAS EM FORMATO “U” ou “L"

Menu: Na aba “Arquitetura” (Architecture), clicar no comando E* ou HH , na
secdo “Circulacao” (Circulation).

Propriedades (Properties): “Restricdes” (Constraints) -> Define-se o “Nivel Base”
(Base Level) de inicio e o “Nivel Superior” (Top Level) que terminard a escada.
A escada em “U” ou “L” sdo aquelas que ja vem predeterminadas no Revit, sem
opcao de modificacdo por parte do projetista.
Para executar uma escada em “U” ou “L”:
e C(lica-se no ponto onde sera posicionada a escada;
e Finaliza-se a escada clicando no botdo Qf .

3.6.3 —ESCADA EM ESPIRAL

Menu: Na aba “Arquitetura” (Architecture), clicar no comando (& ou @ na
secao “Circulacao” (Circulation).

Propriedades (Properties): “Restricdes” (Constraints) -> Define-se o “Nivel Base”
(Base Level) de inicio e o “Nivel Superior” (Top Level) que terminard a escada.

A escada em espiral é aquela com formato circular que o projetista pode
desenhar de acordo com o seu projeto. O seu lance de escada ser menor ou maior que
3609.

Para executar uma escada em espiral:

e Define-se a linha de localizacdo da escada (é recomendado suporte externo
direto);

e C(lica-se em um ponto inicial;

e Arrasta-se para definir o angulo interno da escada;

16
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e Clica-se em um ponto final;
e Finalize a escada clicando no botao Qf

Observagao: No Revit, uma vez que o projetista cria a escada, é gerado
automaticamente seu corrimao, detalhe que também pode ser editado de acordo com
o que se deseja. Quando a edificagdo possuir mais do que dois pavimentos o projetista
pode, apenas, fazer uma cépia da escada para os niveis desejados.

3.6.4 —MODIFICANDO UMA ESCADA EXISTENTE

E possivel modificar as propriedades ou editar uma escada que ja foi criada
anteriormente. Paraisso, basta clicar no comando e realizar as alteragbes de
material ou estilo desejadas. Seguindo, para modificar o que foi criado basta clicar no
icone &3 e realizar as referidas modificagdes.

3.7 —GUARDA CORPO
Neste software, os guarda-corpos podem ser identificados com grades ou
corrimaos. Quando inseridos, os corrimdos e balaustres sdo adicionados
automaticamente em intervalos igualmente espacados, porém é possivel também
editar sua configuracdo e deixar de acordo com o desejo do projetista.
Menu: Na aba “Arquitetura” (Architecture), clicar no comando fE na secdo
“Circulagdo” (Circulation), e logo ap6s em i cominho do croa

Para inserir um guarda-corpo, deve-se:

e Para facilitar a execugdo do guarda-corpo, clica-se nobotdo 7 para escolher
um hospedeiro para o guarda-corpo, como um piso, rampa ou escada, clicando na
estrutura.

e Define-se o tracado do guarda corpo com as ferramentas de desenho;

e Finaliza-se o guarda-corpo clicando no botao Qf
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FIGURA 3.6 — EXEMPLOS DE GUARDA CORPOS

3.8 —TELHADOS

Apds a estrutura da edificacdo ter sido criada, seleciona-se o nivel em que se
deseja criar o telhado. Para acessar esse comando basta ir na aba “Arquitetura”
(Architecture), e clicar em “Telhados” (Roof). Existem trés tipos de telhados que podem
ser trabalhados no Revit, sendo eles:

e Telhado por perimetro (Roof by Footprint): telhado convencional de sobrados e
residéncias;

e Telhado por extrusdao (Roof by Extrusion):. usado em casos em que se deseja
modelar o telhado com retas e arcos, como pavilhdes e ginasios;

e Telhado por faces (Roof by Face): cria um telhado usando uma face nao vertical
de uma massa.

Vale ressaltar que no software é possivel também editar detalhes do telhado
como as Calhas (Gutter), intradorso (Soffit) e a Fascia.

Selecionada a opc¢ao “Telhado por perimetro” (Roof by Footprint), define-se a
ferramenta de desenho. E possivel definir um tamanho de beiral prévio ao desenho do
telhado na opcdo “Deslocamento” (Offset), especificando o valor desejado de acordo
com a unidade pré definida no template. Para melhor visualizacdo do telhado apés feito
o seu desenho no projeto, basta visualiza-lo na vista 3D.

Para alterar as inclinagdes das faces do telhado, seleciona-se a face que se deseja
alterar e, com dois cliques no angulo (2) informado, altera-se para a inclinagcdo desejada.

Para modificar o numero de aguas do telhado no nivel em que foi criado,
seleciona-se 0 mesmo e é preciso que se desmarque a opg¢do “Define Inclinacao”
(Defines slope), no canto superior esquerdo.
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Observagao: Caso a parede ndo siga até o encontro com a cobertura, seleciona-
se as paredes e na aba “Modificar parede” (Modify Wall), seleciona-se “Anexar
topo/base” (Attach Top/Base) e, em seguida, clica-se sobre o telhado.
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FIGURA 3.7 — TELHADO

3.8.1 —EDITANDO O TELHADO

Quando o telhado ja estd feito, porém é necessario alterar o seu perimetro, basta
clicar no telhado e acessar a opcdo “Editar Perimetro” (Edit footprint), na se¢do Modo
(Mode). Além disso, é possivel ainda fazer modificacdes em toépicos como o material, a
sua espessura ou até mesmo adicionar outras camadas para somar detalhes estruturais
como madeira e isolamento, acessando o atalho de “Editar Tipo” (Edit Type), na aba
Propriedades (Properties).

3.8.2 —CALHAS

A insercdo de calhas no Revit, ocorre de maneira bem simples, basta acessar a
opcao “Telhado: calha” (Roof: Gutter), no comando “Telhado” (Roof), localizado na aba
Arquitetura (Architecture) do software. Em seguida, no nivel que estd a cobertura,
define-se as bordas que serdo contempladas com a calhas.

Para a edicdo de comprimentos, seleciona-se a calha e usa-se o comando
“Adicionar/Remover Segmentos” (Add/Remove Segments).
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3.9 —MosilAa

Para adicionar detalhes arquitetonicos e de interiores em um projeto produzido
no Revit, é preciso saber que isso faz parte de um grupo maior dentro do software,
identificado como “Componente” (Component), que contempla um fator importante no
programa, definido como “Familias” (Families), que nada mais é do que um grupo de
elementos com um conjunto de propriedades comuns, chamadas de pardmetros, e uma
representagdo grafica relacionada. As variagdes na familia sao chamadas de Modelos e
Tipos. Esse ponto contempla uma das principais ferramentas ofertadas pelo Revit.
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FIGURA 3.8 — CASA MOBILIADA

Apply

3.9.1 — COMPONENTES

Para inserir componentes ao projeto e, desta forma, mobiliar toda edificacao,
basta clicar no botdo “Componente” (Components), na se¢do “Construir” (Build) da aba
Arquitetura (Architecture). Vale ressaltar que para acessar esse menu, o programa conta
com um atalho prévio, bastando apenas digitar as letras “CM”.

O software em si, ja conta com uma série de familias para os mais diferentes
elementos do projeto. No entanto, é possivel obter um ndmero maior e mais
diversificado para cada um desses itens, detalhe que sera explicado no tépico.

3.9.2 —DOWNLOAD DE FAMILIAS

Como citado anteriormente, o Revit ja possui uma biblioteca propria de familias,
porém é interessante que ha a possibilidade de aumentar os modelos disponiveis, seja
de mobilidrios, colunas, vigas ou até mesmo esquadrias, que podem ser baixados na
internet. Um detalhe importante é que, dependendo do modelo ou fabricante de algum
produto, é possivel que se encontre a familia de um item que é disponibilizado no
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mercado, ou seja, aumenta cada vez mais a fidelidade do projeto pelo fato de, quem
sabe, estar estimando o verdadeiro produto que sera instalado no futuro. Apds feito o
download, é preciso carregar o arquivo para o Revit e, se precisar, fazer as alteragdes
necessarias na op¢ao “Editar Tipo” (Edit Type).

A seguir, uma lista de sites que disponibilizam esse tipo de material:

e BlMobject: https://www.bimobject.com/;

e Revit City: http://www.revitcity.com/index.ph;
e Autodesk Seek: http://seek.autodesk.com/;

e Contier: http://contier.com.br/downloads.

Para inserir uma familia no Revit, é preciso seguir esses passos:
e Entrar na aba “Inserir” (Insert);
e Clicar em “Carregar familia” (Load Family);
e Irad abrir uma nova janela na qual deve-se procurar pelo arquivo que foi realizado
download;
e Clicar em abrir e o arquivo sera carregado pelo software.

Uma vez inserido o arquivo no projeto, ele serd automaticamente carregado no
menu “Componentes” (Components). Desta forma, pode-se inserir o objeto quantas
vezes precisar, conforme o necessario.

3.9.3 —EDICAO DE COMPONENTES

Como ja dito anteriormente, é possivel também editar as configuracdes do
material inserido no projeto. Para isso, é preciso que:
e Seleciona-se o componente que se deseja alterar;
e No menu “Propriedades (Properties), clicar em “Editar tipo” (Edit type);
e Duplica-se o componente e define-se um novo nome;
e Faz-se as modificagdes necessarias e apods isso, salvar.
Observagao: quando se duplica um componente, suas configuracdes originais
serdo preservadas para assim serem usadas novamente em outros projetos.

3.10 — PaisaGIsMO

O projeto de paisagismo fica a critério, sobretudo, do projetista. Para inserir
elementos de paisagismo, segue-se o mesmo procedimento que para colocar novos
componentes.

Para inserir, é necessario apenas seguir 0S mesmos pPassos para usar um
componente, afinal o menu desse item assume essa mesma configuracdo nesse
software. Logo, o procedimento para edicdo dos mesmos, segue também da mesma
maneira.
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3.11 — TOPOGRAFIA

Através de curvas de nivel ou até outros pontos quaisquer de alguma superficie,
é possivel iniciar a topografia que serd ilustrada no projeto. A seguir sera explicado como
criar essa superficie topografica através de pontos.

Menu: Na aba “Massa e Terreno” (Massing & Site), na secao “Modelar Terreno”
(Model Site), clicar em “Superficie Topografica” (Toposurface) e em seguida no icone @

Propriedades (Properties): “Restricdes” (Constraints) -> Define-se o material
desejado.

Quando é criado uma superficie topografica por ponto, cada ponto pode ter sua
elevacdo diferente para assim poder criar a superficie da maneira que ele gostar ou
simular uma real. A seguir sera demonstrado como inserir uma superficie topografica
com todas as elevagdes dos pontos na mesma cota.

Para executar uma superficie topografica por ponto:
e Seleciona-se uma vista 3D;

e Define-se a elevagdo do ponto inicial;

e C(lica-se nos pontos desejados;

e Finaliza-se a superficie topografica clicando no icone Qf .
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FIGURA 3.9 — TOPOGRAFIA BASEADA EM QUATRO PONTOS DE MESMA ELEVAGAO

3.12 — ORIENTACAO SOLAR

A orientacdo solar permite ao projetista realizar um estudo solar na edificacao,
sendo possivel observar os efeitos que o sol causa em uma edificacdo. Ha opc¢des de
visualizar o efeito solar no interior da edificacdo e no projeto como um todo, bem como,
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as suas sombras. Em seguida serd demonstrado como configurar a orientacdo solar e,
também, os diferentes estudos solares que podem ser feitos no projeto.

Para realizar a orientagdo solar do projeto, é necessario ativar o caminho do sol
e as sombras clicando nos botdes <% e (% localizados na Barra de Controle de
vistas, na parte inferior da interface. Em seguida deve-se clicar em “Configura¢do do sol”
(Sun Settings) e aparecerd o seguinte menu.

Como se pode observar, o projetista devera preencher a localizacdo do projeto,
o dia do ano e a hora desejada. Também no canto esquerdo estdo visiveis os quatro
tipos de estudos solares.

lluminagdo: representa a influéncia solar em uma posicao especifica
determinada pelo projetista através de uma imagem.

Estatico: representa a influéncia solar em uma determinada data e hora através
de uma imagem.

Dia unico: representa a influéncia solar ao longo de um determinado dia através
de uma simulagdo do movimento do sol no dia.

Multiplos dias: representa a influéncia solar ao longo de varios dias através de
uma simulacdo o movimento do sol no dia. Nessa opcdo pode ser analisado o
movimento solar ao longo de um ano.

Depois de finalizado, deve-se clicar na op¢do “OK”. Para observar o estudo solar

elaborado, é preciso entrar em uma vista 3D e clicar no bot3o * e depois na op¢3o
visualizar estudo solar.

«

Autodesk Revit 2020 - STUDENT VERSION “®ma W -

REHG G- -8 =-20A & oF%@-
A

chitecture | Structure  Steel  Systems Insert  Annotate  Analyze  Massing&Site  Collaborate  View Manage  Add-ns  Modify (-

5008 0 | FPEOBEE BOS ALK

Modifyl Wall Door Window Component Stair
- . System Grid . Text

Select v Build Cireu

vser - Template_Bruno X {2 3DView3 @ 6o X [ Térreo ¥ Properties X

3D View: {30}
Graphics
View Scale

ity
Visibility/Graphics Ov..

Sun Path

West
B Legends.

Orthographic
52478
28258

10 BEHCQGARNE R 0 AMEE ¢ >
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 0 E\

FIGURA 3.10 — ORIENTACAO SOLAR

23



CAPACITAGAO: INTRODUGAO AO REVIT

CAPITULO 4 — INFORMAGOES E VISTAS DO PROJETO

4.1 - CoTAS

Visando definir as dimensdes do projeto, é possivel utilizar os comandos na se¢ao
“Cota” (Dimension), na aba “Anotar” (Annotate). Outra maneira de acessar essa opgao
é digitando o atalho “DI”.

Vale ressaltar que é possivel determinar os pontos de referéncia para se estipular
as cotas dos ambientes da edificacdo. Por exemplo, determinar se a referéncia serd no
centro da parede ou em uma de suas faces.

4.2 — DETERMINACAO DE AMBIENTES

Serve para a identificacdo dos ambientes, podendo incluir também informacgdes
como sua area ou volume. Para isso, é necessario acessar o comando “Ambiente”
(Room), na se¢do “Ambiente e Area” (Room & Area). Uma vez acessado, ele identifica
os limites do determinado comodo e insere uma identificacdo para o mesmo, que pode
ser editando reescrevendo para o nome correto daquele lugar. Para incluir a drea ou o
volume nas informacgdes, basta mudar a opgao no menu “Propriedades” (Properties), de
“Identificador de ambiente” (Room tag) para “Identificador de ambiente com area”
(Room Tag With Area) ou “ldentificador de ambiente com volume” (Room Tag With
Volume).
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4.3 — CORTES E CAIXAS DE CORTE

Outra ferramenta que o software disponibiliza para enriquecer os detalhes de
um projeto é a projecao de cortes, processo que é feito de maneira simples e
satisfatdria. O processo se da basicamente acessando a aba “Vista” (View) do Revit,
clicando no botdo “Corte” (Section) e, pds isso, definir o local que se deseja realizar o
corte. Uma vez feito isso, sera gerado um tépico no menu de “Navegador do Projeto”
(Project Browser), chamado “Cortes” (Sections), onde sera formada a vista de todos os
cortes inseridos no projeto.

Outra maneira mais rapida de realizar uma espécie de “corte momentaneo” do
projeto, é acessando uma vista 3D do projeto e selecionando a caixa de opg¢do “Caixa de
corte” (Section Box), no menu “Propriedades” (Properties), onde sera criado, de fato,
uma caixa, que permite fazer cortes paralelos na planta, apenas arrastando suas faces.
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FIGURA 4.2 — CAIXA DE CORTE

4.4 — CAMERA

Essa opcdo serve para obter uma perspectiva do projeto, buscando obter uma
visdo de observador do ambiente. Para acessa-lo, basta ir na aba “Vista” (View),
selecionar a opgdo “Camera” (Camera) nas op¢bes do comando “Vista 3D” (3D View).
Com o comando ativado, basta clicar onde se deseja ter a perspectiva e arrastar o mouse
na direcdo que se deseja visualizar. Feito isso sera gerada a perspectiva, ficando salva
no item “Vistas 3D” (3D Views), no menu “Navegador de projeto” (Project Browser).
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CAPITULO 5 — RENDERIZAGAO E PLOTAGEM

5.1 — RENDERIZAGAO

O processo de renderizagdo consiste na criagdo de modelos tridimensionais
basicos de um projeto, definindo a forma e o modelo de acordo com a preferéncia do
usudrio. E possivel aplicar recursos como texturas, iluminagdo na superficie ou modificar
a aparéncia do objeto. E uma maneira de se obter um resultado prévio, com riqueza em
detalhes, para aquilo que, futuramente, serd construido. Esse comando é encontrada na
aba “Vista” (View) e apds isso em “Render”.

Existem programas que importam os arquivos do Revit e fazem esse processo de
renderizacdo, porém o que é disponivel no préprio software ja oferece um resultado
muito satisfatério. Porém, para isso, é preciso seguir alguns procedimentos,
anteriormente, sendo eles:

e Demarcar aregido da vista 3D que se deseja renderizar;

e Configurar a qualidade da renderizacao;

e Em configuracdo de saida, a resolucdo da tela serd compativel ao da
regido da imagem. Se optar pela opcao “Impressora” (Printer), pode-se
definir um nimero maior de DPI, que basicamente consiste na resolucao
da imagem de pontos por polegada, logo, quanto maior esse numero,
maior a qualidade da imagem;

e Define-se as configuracdes de iluminacdo, tanto externa, quanto interna,
levando em consideracdo pontos como a iluminacdo solar e artificial da
edificacdo;

e Configura-se a posicao do sol, levando em consideracdo quesitos como
cidade, horario e época do ano;

e Configura-se o plano de fundo da imagem na sec¢dao “Segundo Plano”
(Background), definindo a opcdo climatica do céu;

e Ajustar a posicdo da imagem e algumas configuracdes de renderizacao,
por exemplo, ressaltando sombras ou cores.

Vale ressaltar que o tempo de renderizacdo, em média, é alto, e varia de acordo
com a capacidade de reproducdo do computador que estd sendo executado o programa,
bem como a qualidade selecionada e os detalhes inseridos.

Outro ponto importante é dizer que as perspectivas criadas pelo comando
“Camera”, podem, também, ser renderizadas com as mesmas caracteristicas, sendo o
mais comum de ser observado em projetos de Engenheiros e Arquitetos que pretendem
divulgar seus projetos, uma vez que o comando demonstra a posicao de observador da
edificacdo.
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FIGURA 5.1 — EXEMPLO DE RENDERIZAGAO PELO REVIT

5.2 — PLOTAGEM

Finalizado o projeto e passando para a parte de plotagem do mesmo, o Revit
permite que se insira uma folha padrao, conhecida popularmente como a Prancha do
Projeto, ou utilizar a que ja é disponibilizada no software, alterando, claro, as
informacgdes contidas nela, como nome do responsavel técnico, empresa, entre outros.

Para adicionar uma folha, é preciso acessar a aba “Vista” (View), clicar no botao

3
3 na secdo “Composicdo da folha” (Sheet Composition). Pds isso, é necessario
selecionar o tipo de folha (A0, A1, A2, A3 ou A4) que se deseja trabalhar.

Usando as ferramentas da secao “Criar” (Create), é possivel acrescentar linhas,
entre outros itens, e na aba “Inserir” (Insert) é possivel incluir imagens. Apds todas as
configuracOes serem alteradas, é possivel salvar a folha como um template (.rfa) que
pode ser utilizado em projetos futuros.

Para adicionar planta baixa na prancha, basta arrastar o nivel que se deseja plotar, do
“Navegador de Projeto” (Project Browser). Para plotar uma folha em formato PDF, é
preciso acessar o comando “Imprimir” (Print). Apds isso, seleciona-se a impressora
desejada (recomenda-se algum programa gerador de PDF). Apds clique em configurar
para alterar a qualidade da plotagem, tamanho da folha, configuracdo das cores e
demais configuracdes, finalizando o projeto.
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Esse material foi desenvolvido com o intuito de torna-lo uma segunda edicdo da
apostila de Introdugdo ao Revit, desenvolvido, também, pelo grupo PET Engenharia
Civil FURG, no ano de 2018. Este, por si s6, foi elaborado para a capacitacdo de
Revit.

Integrantes do grupo PET — Engenharia Civil FURG:

Antoniele Nascimento, Bruno Alvarenga, Carolina Padilha, Cindy Botelho,
Fernanda Barbosa, Gilberto Rech, Giulia Vassao, Isadora Bandeira, Juliane Falc3o,
Kaiane Rosa, Lorenzo Porto, Maria Julia Carvalho, Mariana Levien, Matheus Pereira
e Suane Augusta

Tutor: Prof? Milton Luiz Paiva de Lima

E proibida a reproduc3o total ou parcial da seguinte apostila sem a
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